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Chapter 1. Introduction

Introduction

Diais an application for creating technical diagrams. Itsinterface and features are loosely patterned after
the Windows program Visio. Features of Dia include multiple-page printing, export to many formats
(EPS, SVG, CGM and PNG), and the ability to use custom shapes created by the user as simple XML
descriptions. Diais useful for drawing UML diagrams, network maps, and flowcharts.

This document describes version 0.96 of Dia




Chapter 1. Quickstart
What Can You Do?

Diais adiagraming application made for many people. Diais easy enough to learn without much hassle
and flexible enough to make the power users fedl right at home with their commercial tools. Below isan
example of what five minutes of using Dia can provide.

Figure1l.1. Demo
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Starting Dia

You can start Dia by going into the Applications section on the Main Menu and clicking on the Diaicon.
Or, you can type dia in a console window or xterm.

Quickstart Introduction

The Dia Quickstart is for the user who doesn't want to read a whole manual to make a basic diagram.




Quickstart

Creating a Canvas

All diagrams are drawn in their own canvas. To create a new canvas, select File # New Diagram A new
canvas window will appear.

Making a Diagram

A diagram is made up of objects. Objects are shapes that can be different colors, shapes, and sizes. They
include everything from 2-bit images to full color picturesto text.

To add object to the canvas, click on an object in the toolbox and click on the canvas. The selected object
will appear. The object can be manipulated mainly by clicking and dragging on the green corner buttons.

In the toolbox, you can double-click on any object to view its advanced properties. This allows you to
customize the stock shape more to your liking.

Layers create multiple-images so they are one image. By doing this, a user can edit one layer without
worrying about affecting any of the other layers.

Transparency allows objects to have transparent parts of an object, so anything behind the transparent
section shows through.

Plug-ins allow the average user to easily add new object typesto Dia, to help extend its functionability.

Saving and Printing Your Diagram

Saving your diagram and printing your diagram is as easy as creating and modifying your document.
Dia supports saving and printing to printers. If you have gnome-print installed, the printing is very easy!
The print command can be found in the File menu when right-clicking on the canvas.

Dia supports exporting to numerous formats for excellent web publishing. Some of them include:

» Computer Graphics Metafile (.cgm)

 Encapsulated Postscript (.eps)

» Native DiaFormat (.dia)

Portable Network Graphics (.png)

 Scalable Vector Graphics (.svg)

Who Does Dia Appeal To?

Diacan appeal to many peoplein avariety of industries.
» Anélectrical engineer may use Diato create a diagram to show how their circuit works.
* A computer programmer may use aflow chart to show the execution path of their program.

» A network administrator is able to create a diagram to show how their company network islayed out.




Chapter 2. The Canvas

Canvas Introduction

Grid

The canvasisthe main part of Dia. The Diacanvasisthewindow where all the user's objectswill be placed
on the screen and arranged. When the diagram is printed or saved, the contents of the canvas will be saved.

Lines

Grid linesare similar to the lines on graph paper. They allow the user to easily align objects on the canvas.
The grid lines can be temporarily hidden for the current document choosing the menusitem View # Show
Grid . Thegrid lines can be turned hidden for all new documents by going into File # Preferences . In the
Grid Linestab, click the checkbox labelled Visible and leave it empty to hide the grid lines.

Rulers

Rulersappear on thetop and theleft of the Diacanvas. They show, in centimeters, how largeyour canvasis.

On each ruler exists an arrow. The arrow moves on the ruler in coordination with where the mouse pointer
is. For example, if the user moves the mouse up, the vertical ruler's arrow will move up, indicating the
change. These arrows become useful when an object needs to line up exactly at a certain measurement
point.

Rulers can betemporarily hidden for the current document by choosing the menuitem View # Show Rulers
. Rulers, unlike grid lines, cannot be turned off by default for new documents.

Background Colour

The background colour option alows you to change what the background looks like in the canvas. By
default, the colour iswhite. However, the colour can be changed by going into View + Diagram Properties
# Background and clicking on the bar. The bar displays the current background colour. The gridlines will
change their color automatically to stay visible if the background color is changed to black.

Zooming

Zooming allows the user to get up closer to their diagram. This helps to let the user make precision
drawings.

The canvas can be zoomed up to 400%. Zoom can be done by clicking on the magnifying glass on the
toolbox and clicking on the canvas. To zoom out, hold the shift button and click again on the canvas.




Chapter 3. Objects

Objects Introduction

Objects are what makes up a diagram. Objects are shapes which are either pre-defined or user-defined.
Using Objects
Adding Objects

Adding objects to the Dia canvas can be accomplished by clicking on the desired object in the Toolbox to
select what you want placed on the canvas. Clicking on the canvaswill then place the object on the canvas.

Dia provides two types of objects:

» User-defined objects allow a user to create their own objects, which are based off of a prefabricated
template.

For example, clicking on the sguare object and placing it on the canvas, creates a square. However, the
dimensions of the object can be changed. See the Resizing Objects section for more information.

* Pre-defined objects are mostly designswhich cannot be edited. They can be resized, but the object itself
cannot be edited.

Moving Objects

When an object is inserted into the canvas, the desired object will appear with small green boxes (also
known as handles) defining the borders.




Objects

Figure 3.1. Adjuster Dots

ik -
The area inside the boxes is the object area. Click and hold on the object area. Then move the mouse
around, inside the canvas, to move the object to another place on the canvas.

L

Resizing Objects

The previous paragraph, explains the concept of the green boxes. These are used to manipul ate the size of
the object. To change the size, click and hold on a green button. Drag to the respective size, then let go.

The corner green buttons will change both the height and the width at the same time. The two on the top
and bottom edges, in the center will edit height while the two on the left and right edges, in the center
will edit width. Some shapes

Tip

To drag with the corner buttons, but keep proportions, hold the shift key whileresizing. Thisonly
appliesto the specia objects, not regular shapes.

Deleting Objects

To delete an object, click on the object to select it. The green boxes will appear to indicate the object is
selected. From the menus choose Edit, Delete.

Aligning Objects

Dia provides some functionality to help arrange mulitple objects without needing to move each object
individualy.




Objects

Grouping Objects

Grouping allows you to treat several objects as a unified group that acts alot more like asingle object. A
group enables you to fix the position of the objectsin releation to each other. Select more than one object
and then from the menu choose Object, Group to group them.

Line Properties

One of Dias objectsistheline. Theline object is symbolized by the following icon:

Figure3.2. Thelineicon

N

Line Styles

Lines can be easily edited to easily create items such as arrows. At the bottom of the toolbox is 3 buttons
with lines through them. Clicking and holding will open up a menu which demonstrates what the change
will look like.







Objects

Lines can employ different style types such as:

Solid

Dashed
Dash-Dot
Dash-Dot-Dot
Dotted

Line Thickness

The thickness of lines can be edited by clicking on the five thicknesses to the right of the color selector.

Arrows

Thelinetool can be used to create arrows. By clicking on the two side buttons on the bottom of thetool box,
amenu pulls out showing the possible beginning and end designs for the arrows.

Line Colors

Theline color can be edited by double-clicking on theline onceit has been placed on the canvas. A window
will show up. The second lineislabeled as"Line Colour”" with abar demonstrating the selected color. By
clicking on the bar, you can change the color of the line.

Object Properties

Each object has its own properties assigned to it. They can be accessed by double-clicking on an object
already on the canvas. A window will appear allowing you to edit numerous properties including:

* Linewidth

* Linecolor

among others.

Colors

All the objects can be colored in different ways, according to a user defined setting.

The color control is located near the bottom of the toolbox. There are two squares make up the control.
The one on the top left is the foreground color. The one in the bottom right is the background color. To
edit the colors, click on the desired box and select the color in the color window that appears.

Note

This control will only alow the selection of colors of objects which have not yet been placed
on the canvas.

Tip

To inverse the colors, click on the little arrow to the top right of the two boxes.




Objects

Tip

To set the colors back to the default, click on the black and white box to the bottom left of the
color selector.
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Chapter 4. Basic Objects

Basic Objects Introduction

Thefirst, and most common type of object isthe basic object. Basic objectsnormally are geometric shapes,
which can be customized. Dia offers the user numerous basic objects.

Text
Dia supports the use of text as its own type of object. Text can be placed on the canvas by clicking on
the text button on the toolbox.
Note
Text in Dia can use any font available to Gnome.
Box

The boxes in Dia can be customized to be any size desired by the user. The properties available are;
» Corner Rounding - Causes the corners to be rounded instead of hard edges.

» Draw Background - Keeps the center clear or fills with the background color.

Ellipse

An dllipseis a shape which has all rounded sides, such asacircle or an oval.

Polygon

A polygon is any closed shape made up of straight lines. The polygon tool, allows the user to draw any
shape with all straight lines.

Beziergon

A beziergon is similar to the polygon as the user defines the shape. However, it differsin that it alows
curvesto exist in the shape.

Line
A line simply...aline. Refer to the customizing aline section to find more information about aline.

Arc

An arc isalinewhich has been bent to create a semi-circle shape.

Zigzag Line

A zigzag lineisaline which has sharp, 90 degree turnsin it. They hold visual similarities to staircases.

11



Basic Objects

Poly Line

A poly-lineis like a zigzagline, but does not necessarily have to have 90 degree turns to it. The angles
can be customized.

Bezier Line

A bezier lineis aline which has curvesin it. The bezier line tool is edited by clicking and dragging the
green and orange dots. The green dots customize the size while the orange dots customize the angles at
which the line curves at.

Images

The Dia canvas can have picturesinside of it, as well as shapes.

To add an image, click on the image button and then add it to the canvas. An object that says "Broken
Image" will appear. Double-click to open the properties. Click on "Browse" and select your file. Click
"OK" and then the image will be updated accordingly.

Currently the following image formats are supported for inclusion in Dia diagrams:
* ANI
« BMP
* GIF
« ICO
* JPEG
* PNG

* PNM

* TGA
* TIFF
« WMF
* XBM

« XPM

12



Chapter 5. Special Objects

Special Objects Introduction

The previous discussion explained what a basic object is. The next section goes a step further and teaches
how to create objects, how to use pre-made objects which are more detailed than just shapes, and much

more!

Special Object Categories

Specia objects are broken into different categories or sheets. This way, someone creating a diagram of a
circuit board is shown only the objectswhich apply to them. Diasupports numerous pre-defined categories.

Assorted

Chemical Engineering

Chronogram

Circuit

Civil
Cybernetics

Cisco

PLC Ladder

ER

Function Structure, FS.

Flowchart

Assorted Geometric Shapes. The purpose of this sheet isto provide
a selection of simple and convenient preset shapes so that users
need not create spend time creating their own basic shapes. The
set includes shapes with constrained ratio such as perfect Circles,
Squares, various type of Triangle and Crosses.

A collection of shapes for modelling the process of Chemical
Engineering.

Uses objects to be used in a chronographic design. These are
common place in timelines.

A group for people interested in creating diagrams of electrical
circuits.

Civil Engineering components.
Shapes for creating diagrams of Cybernetic Circuits.

Cisco includes shapes representing equipment from Cisco a
manufacturer of Computer Networking Equipement.

PLC 'Ladder' graphical programming (electrical controls in
manufacturing automation).

Editor for Entity Relations (ER) Diagrams. Entity Relationship
diagrams are used to represent high level descriptions of conceptual
modelsin terms of how each data entity relates to other datain the
model. They aremost commonly used to model the structure of data
to be stored in a database.

Editor for Function Structure (FS) Diagrams. Note that the Objects
require the use of the context menu to access much of the
funtionality of these objects.

A group dedicated to providing the user shapes which are
commonly used in flow charts. Flow charts can be routinely found
in computer programming, marketing, economics, and any other
semi-linear operation which requires planning.

13



Specia Objects

GRAFCET

|star

Jackson
KAQOS

Map 3D Isometric

Misc.

MSE

Network

DIN Electrical

Pneumatic/Hydraulic
SADT

SDL

Grafcet (or IEC 61131-3 SFC) diagrams. Used in graphical
programming and documenting sequential processes in
manufacturing automation.

A chart shows the step, the action, the transition, and the condition
associated with the transition.

Istar is agent-oriented modelling framework. Istar is also written as
i*.

Jackson Software Design (JSD) method Diagrams.

KAOS Diagrams.

Pseudo 3D isometic shapes for creating Directional Maps.
Microsoft Visio calls these shapes Map, Directional Map 3D.

Miscellaneous shapes that do not fit into any of the other groups.
Includes some Filesystem shapes and an animated clock object that
updatesin real time.

Mobile Subscriber Equipment Components, as used by the United
States Army.

Used by network administratorsto create adesign of their network.

DIN style electrical control schematics (electrical controls in
manufacturing automation).

Allows diagraming of a device which employes hydraulics.
Structured Analysis Design Technique.

Specification and Description Language (SDL) SDL is used to
describe the behaviour of interactive time based systems. SDL
was originaly focused on telecommunication systems, but has
also come to be used to describe process control and real-time
applicationsin general.

Sybase  Designs diagrams display the flow of a Sybase computer network.

UML Unified Modelling Language (UML). UML is a modelling and specification language
commonly used to create diagrams showing the structure of object-oriented computer
programming code, particularly for large scale projects.

14



Chapter 6. Selecting Objects

Selection Introduction

Selecting objectsis probably the most frequently task when using Dia. From the moment you create a new
object to the moment you think the diagram looks the way it should be, you will aways have to select
objects to set them up properly.

When you select objects, you bring focus to an object to edit. An object which is not selected, cannot be
edited.

Sel ecting obj ects can be donein many different ways, and there are al so many operations can be performed
on these selected objects.

You can select abjects to simply drag them around the diagram, or to group them in a logical way to
mani pulate them more easily, to connect them each others, or to simply remove them from the diagram.

How To Select Objects

Basic Selection

The basic way to select an object is by clicking onit.

When the object is selected it appears on the diagram with some little green points on its corners and on
its sides.

Once the green points appeared, you can start manipul ate this object as you wish. When you're done with
it you can desel ect this object by clicking on any free space of the diagram, the green pointswill desappear
and selection of an other object becomes possible.

Multiple Selection

The simplest way to select more than one object at the time, is by clicking on a free space of the diagram
with the left mouse button and moving the mouse while pressing on it. Doing so will draw athin rectangle
on the Canvas. All objects present in this areawill be selected when depressing the button.

An other way to do so is by holding down the Shift key while selecting the objects by clicking them one
by one.

Once your selection is complete, each of the selected objects must appear with its own green points as
described above.

Multiple selection is useful when you want apply the same operation on many different objects and you
don't want waste time by selecting them one by one.

When selected, objectsact likeagroup. Meaning if you try to drag one of them, it isthe whole group which
moves. The sameif you try to delete one of them, it isthe whole group will be removed from the diagram.

Then if you click on any free space on the diagram or if you change to another layer, you will loose the
selection. Or if you want to add some more objectsto your selection, simply hold down the Shift key again
and click on the items you want add.

15



Selecting Objects

Note

Assuming you selected some objects on your diagram, it is still possible to resize one of them
without changing the size or position of other selected objects. To learn how to resize objects see

the Resizing Objects section.

Other Ways for Selecting Objects

Other ways for selecting objects are describe below, all these options can be reached in the Main Popup

Menu under the Select menu :

Selecting al objects

Deselecting all objects

Inverting the selection

Choosing the All option will let you select all the objects present
on the current layer, the same way as you could do it by hand.

This option is a shortcut of when your diagram contains a lot of
objects and you don't want waste your timein selecting objects one
by one.

Selecting the None option will deselect objects you have selected
before. It has the same effect as when you clicking on any free part
of your diagram.

After you have deselected objects you cannot perform any
operation on them anymore. So you have to select them again to
continue

Tip

Often you will have to keep your selections persistent, to
do so, you can form an arbitrary group with the selected
items or cut and paste them in a new layer which will
contain all the objects of your selection.

Admiting you have ten items on your diagram and want to select
only eight of them. One way to select these eight objects can be
done by the Invert option under the Select menu.

Simply select by hand thetwo objectsyou don't need, then check the
Invert option and you will get the eight objects you wanted being
selected and the two others left on their owns.

Tip

Another way to do this is to select All the items as
described above, and then press the Shift key and desel ect
the objects you don't need.

Note

Only objects present in the current layer can be selected.
If an object doesn't want to be select it's probably because
itis situated in another layer. To know how to change the
current layer or how to manipulate many layers, please
refer to the Managing Layers section.

16



Selecting Objects

Selecting Connected Objects

Onereally useful and powerful feature of Diaisits ability of handling connection between objects.

Connections, in Dia, can be used for many purposes. The first, and not the least, is to explicitly specify
adirect relationship between two objects.

The second could be it is easier to manage objects that behave efficiently in following established rules
and can be accessed in afew clicks.

Selecting objects connected to a particular object, is as simple than selecting this particular object, right
click on the Canvas to get the Main Popup Menu appear and click on the Select # Connected button.

If thisobject doesn't have any object connected toiit, it will do nothing. Otherwise, all the connected objects
will be magicaly selected and will form anew group of temporary selected objects.

Note

If you repeat this manipulation again, that will be all the connected objects to this new group that
will be add to the selection.

Y ou can redo the operation until you have selected all objects that were connected all together.

Selecting Transitive Objects

Technic shown above is fine when you only want select a small number of connected objects at the time.

Sometimes you will have to select a whole bunch of objects which are connected all together. This way
of selecting objects step by step isn't efficient.

Thisisthe reason why Dia offers you to do all these steps at once.

To do so, select the root object you desire, then right click on the Canvas to have the Main Popup Menu
appear on screen, but this time choose the Select # Transitive button instead of Connected.

And that'sit, all objects that were connected to the root object you choose are now selected and ready to
be manipulate and waiting for you to apply on them any number of operations you would like.

Selecting Same Type of Objects

Diaimplements some trick to select objects issued from the same type.

Meaning if, for any reason, you need to select objects matching the same type (all Rectangles, Lines or
any custom Shape) you could do it by selecting an object of the type you need to select and click, in the
Main Popup Menu, the Select # Same Type button.

This will automaticaly select al objects which correspond to the type you have chosen. Only objects
present in the current layer will be selected.

17



Chapter 7. Loading and Saving
Diagrams

Loading and Saving Introduction

Diafollowsthe saving model common to most desktop applications: you must explicitly save any canvases
that you wish to retain for future use. To save afile, choose File # Save from the Main Popup Menu. The
resultisastandard savedialog. Y our canvasissaved in DiaXML format. No fileextension isautomatically
added, soitisagood ideato explicitly add '.dia to the name you enter.

Toload acanvasfrom afile previously saved by Diaor created by another application, select File # Open...
fromthe Main Menu Bar. Theresult isan open dial og; select the file you want and choose Open. The open
diaog is standard apart from the popup menu labeled Determine file type. Choose the format of thefileto
open (DiaXML or Drawing Interchange) if Dia does not correctly determine the file format unassisted.

An alternate file-loading method is to start Dia from the command line with the name of the file to open
given as an argument.

File Types

A few words on file types are in order. Y ou should be aware that not all format of files can be re-loaded
into Dia after saving and that most supported file formats lose information to some degree.

Dia Native Diagram Files

The only format guaranteed to be lossless is Dia XML. Happily, you are unlikely to accidentally savein
alossy format because File # Save aways produces afile in Dia XML format.

Files in Dia XML format are automatically compressed using gzip to save disk space. This is almost
necessary since, without compression, even simple diagrams are very large because they store much
redundant information. Dia XML files are already compressed, so further compressing them using other
archive formats will not help make them significantly smaller.

Import Formats

Diais able to import the following file types:
 Scalable Vector Graphics (.svg)

» AutoCad Drawing eXchange Format (.dxf)
» XFig File Format (.fig)

» GdkPixbuf bitmpa graphics (.bomp, .gif, .jpg, .png, .pnm, .ras, .tif)

Exporting: Support for Other Formats

Dia supports exporting to many other types of file, such as:

e Computer Graphics Metafile (.cgm)

18



Loading and Saving Diagrams

Diacannot load filesin most of these formats. These formats are useful for diagrams that you need to use
in another application or to distribute to users of another operating system that Dia does not support.

To create afile in one of these formats, select File # Export... from the Main Popup Menu. Choose a
name and the desired format in the resulting dialog, which works like a save dialog. An appropriate file

DiaNative Diagram (.dia)

Dia Shape File (.shape)

AutoCad Drawing eXchange Format (.dxf)
HP Graphics Language (.plt, .hpgl)
Encapsulated Postscript (.eps, .epsi)
Portable Network Graphics (.png)
Scalable Vector Graphics (.svQ)

Scalable Vector Graphics gzip compressed (.svgz)
TeX Metapost macros (.mp)

TeX PSTricks macros (.tex)

WordPerfect Graphics (.wpg)

XFig format (.fig)

XSLT (eXtensible Stylesheet Language Transformation) (.code)

extension is automatically added.

19



Chapter 8. Customization

Customization

Diacan be changed in afew ways, allowing the user to make Dia fit more to their needs.

To change the behavior settings, select File # Preferences... from the Toolbox Menu Bar. This opens the
Preferences dialog

The configurable propertiesin the User Interface tab are:

Reset tools after create. If this button is checked then the buttonsin the Toolbox will reset to the Modify
Tool after being used once. If the button is not checked then the current tool will stick until another tool
ischosen, which isuseful if you want to draw lots many shapes using the sametool over and over again.

Compress saved files, provides the option to have Dia XML files compressed into much smaller files
using gzip or to leave the Dia XML files as plain text so that they can be more easily edited using other
software.

Reverse dragging selects intersecting objects, means that you can create selections that only need to
cover part of the object you want to select whereas normally you need to create a selection around the
whole of the object you want to select. Reverse dragging means creating a selection by dragging up
and to the left from the point you started your selection, as opposed to creating a selection by dragging
down and to the right. This can be useful if you want to make very precise selections where there are
many objects on the canvas.

Number of undo levels customizes how many steps that the undo tool remembers. Higher numbers let
the user go back more steps to fix an error, but take up more memory. Setting the undo level to zero
does not turn off undo, it gives infinite undo (which means it uses as much of the available computer
memory as possible).

Recent Documents list size allows you to set how many items will be shown in the Recent Documents
section of the File menu.

Use menu bar allowsyou to have amenu bar at the top of each Diagram window instead needing to right
click to access the menus. With the menu bar enabled you can access the object context menu by right
clicking (instead of middle clicking, which isessential for usersthat do not have athree button mouse).

Keep tool box on top of diagram windows ensures that the Toolbox windowsis alwaysin front of all the
diagram windows which makes it easier to keep track of and have quick access to the tool at all times.

Width controls the width, in pixels, of anew diagram.
Height controls the height, in pixels, of anew diagram.
Magnify sets amultiplier that controls the default zoom level of anew diagram.

Snap To makes object edges attract to where the grid lines intersect. This makes it easier for the user
to align objects, as separate objects snap to the sameline.

X Sizelets the user set amultiplier which sets how far the horizontal grid lines are from each other.
Y Sizeletsthe user set amultiplier which sets how far the vertical grid lines are from each other.

Colour sets the display colour of the grid lines.
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Customization

» Page Breaks are lines that indicate where the page edges will be when you print out your diagram.

After you have made all the changes you want, click on OK to apply the changes and close the Preferences
diaog. To cancel the changes and return to previous values, click the Close button. Y ou may preview the
effect of your changes using the Apply button.
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Chapter 9. Managing Layers

Introduction to Layers

In Dia, diagrams consist of the canvas object, layer objects, and diagramming element objects. The layer
object can be likened to that of asheet that sits on top of a canvas. Each sheet can then have diagramming
elements added to it to make up a diagram. Each diagram consists of at least one layer and each diagram
can consist of as many layers as required by the diagramming author.

As agenera purpose, layers aim at being a shortcut for grouping related objects within a diagram. They
alow you to isolate the different parts of adiagram, in the way which you can decide to show only certain
parts of it and not some others will stay hidden even when exporting or printing the diagram.

Tip

Use the --show-layers command line switch to control which layers are visible when batch
exporting.

Inside a layer, any operation you would like to perform on objects are possible through the Main Popup
Menu, then you can act on objects just the way you use to.

Tip

Only objects present in the current layer can be selected. If an object doesn't want to be selected,
you should check if it islaying in the current layer or not.

Each new diagram comeswith the default layer 1abelled "Background”. Of course you can changeits name
and settings to customize it to your needs as you can do with any other layer.

You can use layers to create overlay slide show by drawing each incremental dlide in a layer and
mani pulating which layers are visible. If you want to automate post processing such slide show, you can
use --show-layers command line switch. For example;

<tt>dia --show-layers=Background,Slide3 --filter=eps-builtin --export=foo.eps foo.dia</tt>

will export the Background and Slide3 layers, i.e. the eps output has only these two layers and none others.
Y ou would then repeat the export for each combination of layers you need to produce your slides. Using
this switch and a shell script or Makefile you can automate the export process quite well.

Managing Layers Basics

The Layersdialog is used to manage the order and visibility of each layer in adiagram.

Create a New Layer

Creating a new layer is possible by clicking on the New Layer button at the bottom left of the dialog.
Since the Layersdialog is not diagram specific but application specific, you will have to choose in which
diagram the new layer must go in. To do so, at the top of the Layers dialog, select the diagram you wanted
to receive the new layer and then add this new layer to the selected diagram.

The newly created layer will be placed on top of the stack and will become the current layer of the selected
diagram.

Then it's possible to edit any new object of your choice, copy and paste from any other layer or diagram
asyou could do it in single layer diagram.
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Managing Layers

Selecting Layers

A layer is said as being activated when it is selected in the Layers dialog. To select alayer smply click
on its name in the dialog. The selected layer will then become highlighted. Changes to the diagram are
made to the currently selected layer only.

Note

Only one layer can be selected at atime. That way you can do anything you like in this selected
layer without affecting other layers on your diagram.

Ordering Layers

Next to the New Layer button at the bottom of the Layers dialog, are two useful buttons which allow you
to set the stack order of each layer you created.

Those two buttons are used to raise and lower layers in the hierarchy of layers. The button with the up
arrow is used to raise the active layer while the other is for lower the position within the hierarchy.

Ordering layers can be useful when you want hide some parts of an object with another one.

Deleting Layers

When alayer is not required you can delete it. When deleting a layer, it and all of the objects contained
in the layer are removed from the canvas. Layers are deleted by clicking on the Delete Layer button. Of
course thiswill only affect the currently selected layer.

Doing so on regular basis is the better way to keep your diagram clean and light for when you want to
export it to another format other than the native Dia format.

Renaming Layers

Layers can be renamed to express the part of the diagram they represent, giving them the ability to be
rapidly located among others. Most importantly, layers can be shown or hidden depending on what part
of the diagram you would like to show.

Double-clicking on the name of the layer opensthe Edit Layer Attributes dialog, which displaysthe current
name of the layer in a textbox. Enter a new name for the layer in the textbox. To confirm the changes,
depress the OK button. Selecting the Cancel button will close the Edit Layer Attributes dialog without
making any changes.

Tip
Naming layers that describe the purpose of the layer is a useful way to remember what it is for.
Don't hesitate to create many different layersin your diagram, Dia doesn't constrain you on the

number of layers you've created, so feel free to adjust the hierarchy of the diagram to your own
needs.

Viewing Layers

Now that you've seen what are the basics of manipulating layers, you will more easily understand why
layers are such a powerful tool when you are building and maintaining diagrams with Dia.
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Managing Layers

Understanding what layersare for can dramatically improve the quality and the visual effect your diagrams
will produce.

For instance, imagine you are building a diagram with lots of objects in it, like an Electrical or UML
diagram, if you drop al of your objectsin the same layer, meaning the background, after awhile you will
get ahuge unmanageabl e draft you won't be able to do anything withiit. It will be apain to change anything
init, you will waste time trying to remember what object is connected to that object which seems to take
all the space in the middle of the mixed up objects you already put there.

Since Diais a Sructured Diagram Builder, all the diagrams you will build with it will be naturally
structured and broken down to many little pieces. Using alayered approach better manages lots of pieces
with more ease and efficiency than you could do with a single monolithic block of objects.

Note

By definition, a diagram should be structured. So breaking it down into severa logical parts
should be an easy process. That's where layers become a very useful and important tool for the
management of the content of diagrams. They allow you to isolate each of these partsin separated
dlides, so it becomes areal pleasure to manipulate them in any way you like.

The Eye Icon to the left of the layer name iswhat make layers so useful. It allows you to show or hide the
corresponding layer. Meaning if for any reason you decided to not show a particular layer, simply click
on the Eye Icon and the layer and everything it containswill disappear from the Canvas. If you hold down
the Shift key and click Eye Icon you can hide all the other layers except for the current layer, and if you
click again while still holding the Shift key all Layerswill be shown again.

Viewing only certainlayersisreally useful when you want manipulateasmall part of your diagram without
affecting the rest. Some users create separate layers to hold all their text objects and use different layers
to hold tranglations into other languages. Y ou can also work that way if you want to print your diagram
on different pages or testing different settings which can affect the layout of that part. Again, feel freeto
experiment with layers, if set up properly they can make your diagram look much better.

Note

In Dia, Layers creation and manipulation are as common as drawing or selecting objects in the
diagram. Y ou must get your hands on them, because you will probably have to use them anytime
you will want to creat a new diagram.
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Chapter 10. Authors

Diawas created by Alexander Larsson and is currently maintained by Lars Clausen and other dedicated
volunteers. To find more information about Dia, please visit the official web page, www.gnome.org/
projects/dia [http://www.gnome.org/projects/dia). Please send all comments, suggestions, and bug reports
tothe GNOME bug tracking database [ http://bugs.gnome.org]. (Instructionsfor submitting bug reportscan
be found on-line [http://bugs.gnome.org/Reporting.html].) If you are using GNOME 1.1 or later, you can
aso use Bug Report Tool (bug-buddy), available in the Utilities submenu of Main Menu, for submitting
bug reports. Y ou can also sign up to the Diamailing list [http://mail.gnome.org/mailman/listinfo/dia-list].

This manual was written by Henry House (<haj house@ouseag. con®) , Judith Samson
(<j udi t h@ansonsour ce. con), Kevin Breit (<bat t er y841@rypad. con®) and Alan Horkan
(<hor kana@ cd. i e>. Please send all comments and suggestions regarding this manual to the GNOME
Documentation Project [http://www.gnome.org/gdp] by sending an email to <docs@none. or g>.
You can also add your comments online by using the GNOME Documentation Status Table [http://
www.gnome.org/gdp/doctablef].
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Chapter 11. License

License

Thisprogram isfree software; you can redistribute it and/or modify it under the terms of the GNU General
Public License as published by the Free Software Foundation; either version 2 of the License, or (at your
option) any later version.

Thisprogram isdistributed in the hope that it will be useful, but WITHOUT ANY WARRANTY ; without
even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.
See the GNU General Public License for more details.

A copy of the GNU General Public License isincluded as an appendix to the GNOME Users Guide. Y ou
may also obtain acopy of the GNU General Public License from the Free Software Foundation by visiting
their Web site [http://www.fsf.org] or by writing to

Free Software Foundation, Inc.
59 Temple Place - Suite 330
Boston, MA 02111-1307

USA
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